Additional Instructions for Vector Version 1-3

Copyright © J2M and 4Mation, 1996

This describes the major areas of Vector which have changed from version 1-1 to 1-3 (in case
you were wondering, version 1-2 was produced for the German market only and was never
released in an English version). In addition to the changes described here, there have been
some bug fixes and enhancements to make the application fully compatible with newer
machines and operating systems.

You should note that Vector is now no longer compatible with RiscOS 2. If you are still using
this version of RiscOS then we (and Acorn) would strongly suggest that you upgrade.
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RiscPC support

Various areas have been changed to work correctly with newer versions of the operating
system and to support the enhanced graphics capabilities of the newer machines. Vector
should now operate correctly with large high-resolution screens in any colour depth; all
dialogue boxes and menus have been reformatted to be correctly aligned when the desktop is
using an outline font; and memory for documents is alocated from a dynamic area if possible
in order to improve task switching performance and alow larger amounts of memory to be
used.

Using the system colour picker

If the system colour picker is supported by the operating system (i.e. RiscOS 3-5 and later)
then it can be used for al colour selections instead of the standard 4Mation colour selector.
This option is controlled by the “RiscOS colour picker” option in the “Choices” dialogue
box: if it is selected (changing the option takes effect immediately) then the system colour
picker will be used if possible. If this option is not selected or the operating system does not
support the colour picker then the standard colour selector dialogue will be used.

‘ |V Risc0S colour picker
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Enhancements to printing

The printing system now declares fonts to the PostScript® printer driver, in order to generate
correct output and to interface with FontPrint. Background printing (if supported by the
printer driver and requested in Printers “Connection” dialogue) isimplemented.

Thereis an additional button in the “Print” dialogue “ Generate EPS illustration”, whichis
enabled if the printer driver supports it. Selecting this option causes Encapsulated PostScript
output to be generated: the precise effect of this depends on the printer driver.

Print
Driver PostScript
Resolution Jae x 388

Options

Humber of copies

| Collate multiple copies
| Reverse order of pages

| Manual paper feed
[V Generate EPS illustration

Eancel| | Print |

Sprites and palettes

Due to changes in the way the operating system handles colours and sprites, it is necessary to
ensure that all sprites with 16 colours or less which are to be displayed in their true colours
include a palette. Sprites without a palette are displayed using VDU colours, as opposed to
desktop colours (i.e. the same as would be seen in Paint with its “Use desktop colours”
option turned off).

When loading a sprite with this number of colours and no palette, you will be asked whether a
palette should be added. For a sprite which is normally displayed on the desktop (e.g. an
application or file type sprite) you should answer “Yes” to this. Note that sprites captured
from the screen normally include a palette.
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Quick copy

In addition to the norma copying facilities (“Copy” in the “Select” menu, keystroke
Control-C), selected objects can be copied by pressing the CTRL key and dragging them to a
new position with the Select mouse button. The CTRL key must be held down as you start to
drag, although it can be released once the objects start to move. While the CTRL key is held
down, the Select mode arrow pointer will show a‘+' to remind you that quick copy isin effect;
while dragging the copied objects the hand pointer will show a‘+'. To abort the copy, press
the ESC key before releasing the mouse button.

Menu changes

Some of the menus have been rearranged in accordance with the Style Guide. The “File”
menu |leads to document information, saving and printing options, while the “Drawing” menu
controls settings affecting the drawing file as awhole. These replace the “Misc” and “Save”
menus in earlier versions.

Yegtor File

File | Info [

brawing | Save F3r

Display | Options > Export
Ereate """" N Export figg~| Vector P
sSelect F6 o Print. PRINT | SORTES
Edit F3 = Setup. 4PRINT

Library &6 mf-o7---7 oo os| Poster "
________________ Save defaults

When afile is loaded, its format (MVector, Compressed Draw, Draw or Poster) is remembered
and displayed at the top of the toolbox (and in the “About this file” information box). The
“Save” option in the “File” menu saves the drawing in this format: if automatic save is
enabled, it will also automatically save in this format. The current format can be changed in
the“Options” dialogue: if changed, this format will be used for al saves from then on.
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The entire drawing, or selected objects, can be saved in any other format by using the
“Export” menu. Saving using one of these options does not change the current file format,
the modified state or the remembered file name. The equivalent keystroke (Control-F3) will
pop up an “Export” dialogue for the current file format. Sprites, text areas or text strings are
also saved from this menu.

The option for setting the format of a saved library file has aso been eliminated. Any format
of library file can be loaded; it isaways saved in the format it was originally loaded in. When
the application is started, or the library is cleared, the format is set to to compressed. Merging
alibrary does not affect the format.

The effect of thisis that libraries created in Vector (version 1-20 and later) will aways be in
compressed format, whereas if old libraries are edited in Vector they will remain in their
original format. To convert an old-format library into compressed format, clear the library and
then drop the old library file onto the library window or scrolling list (not onto the icon bar
icon). When the library is saved, it will be in compressed format.

In addition, the “Preferences” option on the icon bar menu has been renamed to “Choices”
in accordance with the Style Guide.

Saving Draw files

When saving or exporting a file in anything other than Vector format (i.e. Draw, Compressed
Draw or Poster), it is automatically converted to standard Draw format while saving. This
means that any file, even if it contains specia Vector objects such as replicates or multi-line
text, can be saved in aform that will be understood by any other application without having to
first convert it using Flatten.

We recommend that you keep a master copy of the file in Vector format so that your saved
settings and any special objects are retained. When you want to transfer the drawing to another
application (e.g. to embed it in a DTP frame), simply load the file into Vector and then drag the
file directly from the appropriate “Save as” box in the “File/Export” menu. (The two
examples in the “Multi-line text” section were imported this way).
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Measurement entry and display

All measurements are displayed with a unit suffix: when entering or changing measurements,
aunit suffix can be added to specify a unit or override the default. The default units are set in
the“Rulers” dialogue; the units which can be used and their suffixes are:

kilometre km
metre m
centimetre cm
millimetre mm
mile mi
yard yd
foot ft
inch in
pica pi
point pt

The units used for display and entry of text size and line width are set independently, in the
same dialogue. These are not scaled in accordance with the user units.

Scale factors (object scaling, text aspect ratio, etc) are displayed and can be entered either as a
percentage (followed by a ‘%), or as adecimal fraction (including a‘.”). The display format
and the default interpretation (used if a value entered neither ends with a ‘% nor containsa“. ”)
can be set in this dialogue.

New dialogues

The 3-D styleisavailable for all of the dialogues, as well as the toolbox and other windows. 1f
using an older machine (earlier than RiscOS 3:-5), NewLook must be used to activate this
feature. The old 2-D templates are still available (and are automatically used if NewLook is not
used or has been turned off).

In order to reduce the size and complexity of the “Rulers” dialogue, it has been split into two
dialogues “Rulers” and “Grid”. The dialogue is opened in the same was as before: the
“Grid...” or “Rulers...” button at the bottom of the dialogue switches between the two and
the “OK” button works in the same way in either. The “Rulers” dialogue controls the current
ruler number, the user and drawing units and scaling, the grid subdivisions and the
miscellaneous units (see above). The “Grid” dialogue controls snapping (independently for
rotation and for other operations), the grid display and the grid style.
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Rulers

brid

Ruler
@1 12 J3 04

Scaling

Lock
[ Createsmovesscale to grid

[V Rotate to steps of °

Drawing | £ || centimetre | G .

User | 1 ||centimetre | H| J P?i"tS Use "Choices"
Divisions | 5 || 9.20 cn fj :;"Eiid g't,'i’fzﬁlgﬂ:fl
Misc Units

Line width [ point |°H| Layout
Text size point ﬂ @ Rectangular (45° angles)

Scale factor

Cance! | Grid...|| 0K |

Percent age :Eﬂ _) Isometric (38° angles)

Eancel| Ruler5“.| | 1]4 |

The “Choices” diaogue has aso been split up into “Options” for setting general options,
and “Colours” for setting display colours. The“Colours...” and “Options...” button at the
bottom of the dialogue box switches between the two, and the “OK” and “Save” buttons work
in the same way in either. Some new options have been added to the “Options” dialogue (see
other sections).

Rotation snapping

Rotation can now be confined to a user-defined step, set in the “Grid” dialogue. The rotation
step is set in degrees: if the option is selected then object rotation with the mouse will be
performed in multiples of this angle. If the option is deselected then rotation will be
completely free with no constraints.

If orthogonal constraint is selected then this will take preference over the rotation step (i.e.
rotation will be constrained to steps of 45° for arectangular grid or 30° for an isometric grid).

This option has no effect on rotation performed viathe “Rotate” dialogue.
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Saved settings

The internal representation of some settings (text line spacing, grid style and orientation) as
stored in the document has changed. When loading a drawing which was created using an
older version of Vector, these settings should be checked and reset if necessary.

Any Acorn settings objects found when loading in afile are silently discarded. The warning
message is no longer given.

Alignment

The “Align” facility can be used if the selection includes a single locked object. In this case,
the locked object is used as the reference and all of the other selected objects are aligned to it.

When aligning to a horizontal or vertical centre, the alignment reference point used will be the
centre of the object which is nearest to the centre of the selection (previoudly, the reference
point was the centre of the overall bounding box of the selection). The effect of thisis that this
object will stay still and all of the other objects will be aligned to it, thus preserving the grid
positioning of the objects (previoudly, if the centre of the selection was not on the grid then all
of the objects would be moved off the grid).

Polygon create

The number of sides for the created polygon is set in a dialogue box rather than a writable
menu: this can be summoned by clicking Adjust on the toolbox icon. The polygon being
created is shown on the screen: the orientation can be controlled by the mouse as the polygon
is dragged out (one corner of the polygon follows the pointer).

Draw file checking

Draw files which may have previously failed to load with error 112 (“Path has no |ine or
curve el enents”) can now be loaded: any offending objects are ignored. Some applications
(e.g. EarthMap) produce files with this error: the appearance of the drawing is not affected,
and these files can now be loaded and displayed.
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Bounding box

The “Bounding box” writable menu is now a dialogue box, and there is an additional
“Group with original” option. With this option off, the dialogue works in the same way as
before. With this option selected, the new box object will be placed immediately behind the
original object and grouped with it. The option is available if one and only one object is
selected.

Bounding box

Separated by

| Group with original

Cancel | | Create |

Manipulating skeletons

A static-skeleton can have its size and layout changed, or it can be converted to a dynamic-
skeleton, using the “Replicate” dialogue: thisworks in the same was as for replicates, except
that some operations are obviously not available.
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Multi-line text

Text objects containing more than one line of text can now be created. This allows a block of
text to be kept together, and yet edited in a single operation (which would not be possible if the
text were created as individual lines and then grouped). A multi-line text object can be edited,
moved, copied, scaled, transformed or have its style changed in exactly the same way as a
normal text object. It can be converted into individua lines of text using the “Explode text”
option on the “Special” menu: it can also be converted to a path.

A text object is created or edited in the same way as before. Two options are available for
multi-line text objects, depending on your preference. In the normal mode, pressing the
RETURN key during text entry or editing completes the create or edit (and starts a new text
object, if in text create mode) in exactly the same way as before. To start a new line within the
same text object, press either the INSERT or the TAB key: the caret will move down to the
next line. The aternative mode is available if the “Multi-line text” option is selected in the
“Choices” dialogue (changing this option takes effect immediately): in this case the action of
the keys is reversed so that RETURN starts a new line of text and INSERT completes the
create or edit. In either case, clicking Select always completes the create or edit.

|V Multi-line text

Text layout is set by the new “Text layout” dialogue in the “Text/Area” menu, which
replacesthe “Line spacing” and “ Kerning” options originaly on that menu:

Text 1layout
Justify Spacing

E| @ Left | Horizontal kerning
E|[ O Centre |00 spacing [ 1184

=| U Right of text size

Cancel 0K |
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The three “Justify” options set the alignment of the text, both for normal and for multi-line
text objects. For a normal text object, changing the justification does not change the
appearance of the text (except that its position will change); however, the effect will be
obvious if the justification is changed and the text is later edited. For multi-line text objects,
the option affects the alignment of each line with respect to the others:

This text has its This text has its This text has its
lines left lines centre lines right
justified. justified. justified.

This dialogue box also allows the line spacing to be set (for multi-line text objects), as a
proportion of the text height:

This text
object has This text
a narrow line .
spacing (85%) object has
. a large line
This text X
object has spacing (150%)

normal line
spacing (100%)

Horizontal kerning (if the font in use includes kerning data) can be selected for any text object.

In addition to the two options above, the actions of some keys during text edit or create have
been changed to work with multi-line text objects (if only normal text objects are being
created, these keys work in the same way as before). Control-Left and Control-Right move
to the start or end of the current ling; Control-Up and Control-Down move to the start or
end of the text. If not at the end of aline, Control-Copy deletes forwards from the caret
position to the end of the ling; if at the end of aline, it deletes the newline and joins the next
line to the current one. If not at the start of a line, Control-U deletes backwards from the
caret position to the start of the line; if at the start of aline, it deletes the newline and joins the
current line to the previous one. Control-X deletesal of the text.

11
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Selection options

Three options are now available (in the “Choices” dialogue) to determine how objects are
selected when a box is dragged to enclose them: this can be changed for personal preference
or to make the selection more or less sensitive if required for a complex drawing. Changing
the option takes effect immediately.

Drag select: ) Touch ) Enclose @ Centre

If “Touch” is chosen, any object whose bounding box touches or intersects the selection box
will be selected (this was the origina behaviour in DrawPlus and Vector if
“Select all touched” was chosen). If “Centre” is chosen, then if the centre of an object’ s
bounding box falls within the selection box then that object will be selected (this is the
standard operation in Draw, and the original behaviour in DrawPlus and \ector if
“Select all touched” was not chosen). If “Enclose” is chosen, only objects whose
bounding box is entirely enclosed by the selection box will be selected: any object larger than
the selection box will not be selected at all.
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